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Topics

• 020 Field - Paperback and Hardbacks in Polaris
• 082 Field - Dewey Dates
• 245 Field - GMDs
• 264 Field - Dates
• 300 Field – Pagination, runtime, extent, etc.
• 504 Field – Index and bibliographical references
• 650 vs. 655 Fields – Subject vs. Genre Headings
• 650/655 Fields - Subject Headings to Change
• 650/655  Fields - Subject Headings to Remove
• Bootlegs, Pre-Pubs, ARCs
• Volume Field Usage in Polaris
• On-Order Records
• Constant Data & Text Strings in Connexion Client
• Policies and Procedures



020 Field: Paperbacks and Hardbacks in 
Polaris
• Hardbacks and paperbacks can be on the same record if 

certain conditions are met.
1. All searching and matching criteria are met (size, pagination, 

publication year, etc.)
• Exception: In cases where the presence of a hardback or paper edition 

statement is the only difference, both edition statements may be included in 
the Polaris record

250 _ _ $a First hardback edition, 1st paperback edition

• An ISBN on a matching item should be added to the 
bibliographic record if not already present.



082 Field - Dewey Dates

• If you assign a Dewey Decimal Classification number according to the DDC 
schedules or to LC practice, use field 082 with (typically) 1st indicator 0 and 2nd

indicator 4. 

082 04 $a

• $2 Edition Information
• Assigned from a printed edition (edition/language of edition/pub year of edition):

$2 23/eng/2012
• Assigned from an electronic version (edition/language of edition/date on which 

the number was assigned by the cataloger):
$2 23/eng/20240403



1XX Fields – Main Entry
• $0 Authority record control number or standard number

• System control number of the related authority or classification record, or a 
standard identifier such as an International Standard Name Identifier (ISNI)

• $1 Read World Object URI
• Identifies an entity, sometimes referred to as a Thing or Real World Object 

(RWO), whether actual or conceptual. 

• OCLC is adding these.

• Do not remove if in the record, but it is not necessary to add them in if it 
is not present.



$0 & $1 Examples
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You may also see $0 and $1 in other areas of MARC Records such as 300 fields, 600 fields, 700 fields, and 800 fields. 



758 Field – Resource Identifier
• An identifier for a resource that is either described in the bibliographic 

record or a resource to which it is related. 
• Resources identified can include, but are not limited to:

• FRBR works
• Expressions
• Manifestations
• Items

• If found in a record, you can leave it in, but it is not necessary to add it 
(at this time) if not in the record.

• See PDF Handout on L2 for additional explanation.



245 Field - GMDs

• SHARE Local Practice Only
• A general material designation (GMD) should be added to all 

records for braille, large print material, larger print material, 
and all non-print formats.

• Add in before the $b or $c field
o245 10 $a Charlotte's web $h [text (large print)] $b a novel / $c by E. 

B. White.

Use of General Material Designation (gmd) | SHARE 
(illinoisheartland.org)

https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards/350
https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards/350


Currently Available GMDs
• Braille

• $h [braille]

• Electronic resource
• $h [electronic resource]

• Filmstrip
• $h [filmstrip]

• Flash card
• $h [flash card]

• Game
• $h [game]

• Kit
• $h [kit]

• Microform
• $h [microform]

• Microscope slide
• $h [microscope slide]

• Model
• $h [model]

• Realia
• $h [realia]

• Slide
• $h [slide]

• Sound recording
• $h [sound recording]

• Text (large print)
• $h [text (large print)]

• Toy
• $h [toy]

• Transparency
• $h [transparency]

• Videorecording
• $h [videorecording]



264 Field - Dates

• If publication date stated
o264_1 $a City, State : $b Publisher, $c year. (period)
o264_4 $c ©year (no period)

• If publication date not stated, look for implied date, and use 
brackets
oEx: ©2020 

 264_1 $a City, State : $b Publisher, $c [year] (No period)

 264_4 $c ©year (no period)
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If publication date stated -> just use it no brackets. If not stated 



To bracket or not to bracket, that is the 
question
• What does the 264_1 look like for:

o©2020 only date given?
oPublication 2020 only date given
oPublication and Copyright both 2020
oPublication 2017, Copyright 2020
oNo publication date given.



Dtst Fixed Field



What's the Dtst?

Publication date 2020, copyright date 2020?

Publication date 2020, copyright date 2021?

Copyright date 2020, no publication date given?

Publication date 2020, no copyright date?



300 Field – Physical Description - Books

• $a Extent
• use for the number of pages and/or number of volumes
• Use last numbered page
• If no numbered pages:

• use 1 volume (unpaged)
• If the book is short, you can count pages and say “_ unnumbered pages”

• $b Other physical details
• Use for any illustrative matter
• Must match codes in Ills field 

• $c Dimensions
• Use for the size of the item

• Measure in cm.
• For books that are wider than tall, measure both width and height



300 Field – Physical Description – Sound 
recordings
• $a Extent

• Use for the number of physical units
• Enter the playing time in parentheses following the carrier type 

when appropriate
• 300 _ _ 2 audio discs (1 hr., 8 min., 57 sec.)

• $b Other physical details
• Prefer use of 344 for recording sound characteristics

• $c Dimensions
• Use for the size of the item

• $c 4 3/4 in.



300 Field – Physical Description – Visual 
materials
• $a Extent

• Use for the number of physical units
• For motion pictures and videorecordings, enter the playing time or number 

of frames in parentheses following the carrier type. 
300 _ _ $a 3 videodiscs (60 min.)

• $b Other physical details
• Use for the other physical details appropriate to the material
• use for aspect ratio and special projection characteristics, sound 

characteristics, color characteristics, and projection speed
$b sound, black and white
$b sound, color

• $c Dimensions
• Use for the size of the item

$c 4 3/4 in.



490 Field – Series Statement

• If a 490 is present -> 300 field 
MUST end in period.
oOtherwise NO PERIOD at 

end of 300 field



504 Field – Index and bibliographical 
references
• 504 field does not necessarily mean includes index.
• Book w/Bibliographical References

o504 ## Includes bibliographical references (pages X-Y).
o504 ## Includes bibliographical references (pages X-Y) and index.

• Book w/Index Only
o500 ## Includes index.

• Don’t forget to change Cont->b and Index->1



650 vs. 655 Fields – Subject vs. Genre 
Headings
• 650 field -> Item is ABOUT this topic
• 655 field -> Item IS this topic
• What does "650 10 Romance fiction" mean?
• What does "655 #7 Romance fiction" mean?



650/655 Fields - Subject Headings to 
Change
• 650 10 Children stories. (used for children stories)
• 650 10 Large print books (used for large print books)
• 650 10 Cookbooks (used for cookbooks)
• 655 #7 Picture books. $2 lcgft (for all children's books)

o Note: In picture books, illustrations are as important as—or more important than—
the words in telling the story.

• 655 #0 is used in limited situations. Change to 655 #7 for 
controlled genre/term headings.
o655 #7 Large print books. $2 lcgft
o655 #0 Young adult fiction. (LC Headings Used as Genre Terms)



650/655  Fields - Subject Headings to 
Remove
• Local Changes!

• FAST Headings
• Sears Headings
• BISACSH
• MIGFG (Moving Image Genre-Form)
• Foreign language subject headings if different than the language of

the item being cataloged.
• Juvenile subject headings when they are the same as LC adult



8XX Fields

• For records with a 490 field, there can be three options for 
the 8XX fields:
o If the series is written by one author and the authority record exists 

for that one author's series
 800 1# Author LN, Author FN. $t Series title.

o If the series is written by multiple authors or by a publishing 
company
 830 #0 Series title.

o If the series does not exist, use a 490 #0
oNOTE: If the series has more than three books, email us and we 

can create a local series authority record.



Bootlegs, Pre-Pubs, ARCs

• The following resources cannot be added to the SHARE 
catalog:

• Advance reading copies (ARCs) or uncorrected proofs of books
• Advance screening copies of videos 
• Pirated or illegal copies in any format

*Items that are considered to be of historical significance may 
be retained but should be marked as non-circulating.



Volume Field Usage in Polaris

• The volume field in item records is only to be used in specific 
circumstances:

• Serials Module – individual issues
• Serial bibliographic record for items that DO NOT circulate in Polaris

• Reference materials, year books, etc.

• Monographic set record for complete works in multiple volumes that 
are published in the same year with the same title. 



On-Order Records

• DO NOT circulate on on-order records!
• Creation

• Barcoding libraries not using the acquisitions module may request 
on-order bibliographic records be created by Bibliographic Services 
staff

• Cataloging libraries not using the acquisitions module can create a 
short bibliographic record using one of the on-order bibliographic 
record templates created by SHARE staff

• Acquisition libraries will generate records after importing orders. 



On-Order Record Requirements
• The full list of on-order record requirements can be found at 

the link below:
• On-order records | SHARE (illinoisheartland.org)

• Applies to on-order records created through Acquisitions 
module and an on-order template.

• Missing information from the required list should be added 
manually if not included in the record after importing through 
the acquisitions module or after using an on-order template.

https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards/328


On-Order Bib Records and Item Records

• Circulation status must be In-Process or On-Order ONLY.
• On-order item records MUST be marked as Holdable with no 

limits even if the library intends to make the item holdable 
only by their patrons when it is received

• DO NOT enter a barcode in any item record attached to an 
on-order bibliographic record

Presenter Notes
Presentation Notes
Item records marked as holdable: allows holds to be placed at the bib level by any patronBarcode: prevents item-specific holds from being placed



Constant Data & Text Strings in Connexion 
Client
• Constant data great for saving static fields (ex. 007 fields and 3XX 

fields for books/videos/etc.)
o Shortcut for constant data "Ctrl + b"
o Cataloging -> Create -> Constant Data -> Action -> Save Record to Local 

File -> Make a memorable name
 If you forget the name you made, look up all Constant Data by Cataloging -> 

Search -> Local constant data -> Enter

• Text string great for adding phrases into fields that are repetitive 
(like GMDs or $e author.).
o Text strings -> Add -> Write your repetitive text and name it -> Ok -> 

Highlight your new text string -> Keymaps -> Highlight your text string -> 
Enter your keyboard shortcut -> Ok.



Searching for LCSH/Authority Names/Etc.



Resources and Links

• Resources | SHARE (illinoisheartland.org)
• SHARE editing checklists

• Bibliographic & Cataloging Standards | SHARE 
(illinoisheartland.org)

• Policies and Procedures

• OCLC Bibliographic Formats and Standards

https://share.illinoisheartland.org/cataloging/resources
https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards
https://share.illinoisheartland.org/policies-and-procedures/bibliographic-cataloging-standards
https://www.oclc.org/bibformats/en/home.html
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